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I. IDENTITY OF PETITIONER

Ronald Wafford, defendant in the trial court, is the

petitioner herein.

n. CITATION TO COURT OF APPEALS DECISION

On May 15, 2017, Division I of the Court of Appeals

issued its decision denying the defendant's appeal. A true and

accurate copy of the Court of Appeal s decision will be found

in Appendix A.

m. ISSUES PRESENTED FOR REVIEW

1. Whether the trial court erred when it allowed the
State to introduce hearsay evidence to rebut
assertions made by defense counsel during her
opening statement.

IV. GROUNDS FOR ACCEPTING REVIEW

RAP 13.4(b) reads in relevant part;

(b) Considerations Governing Acceptance of Review. A
petition for review will be accepted by the Supreme
Court only:

(1) If the decision of the Court of Appeals is in
conflict with a decision of the Supreme Court; or



Mr. Wafford maintains that this Court should grant

roview under this subsection for reasons set out more fully in

section VI.

V. STATEMENT OF THE CASE

When Mariyah Wafford heard rumors in 2005 that her

husband, Ron Wafford, had touched her eight-year-old

daughter, TH, she took steps to protect her and her older

daughter, HF. RP 1264-68, 482 Mrs. Wafford briefly discussed

the rumor with her daughters, primarily HF, and the matter was

reported to the police. A child forensic interview specialist.

Nova Robinson, interviewed TH at Dawson Place, the

Snohomish County Center for Child Advocacy. TH, during this

videotaped interview with Ms. Robinson, did not make a

disclosure deemed sufficient to either charge Mr. Wafford with

a crime or to continue the investigation. Mr. Wafford, who had

moved out of the home during the initial investigation, moved

back into the home.



Seyen years later, in 2012, another allegation against Mr.

Wafford was reported, again allegedly involving TH. Once

again TH was interviewed at Dawson Place. Again, she denied

that her stepfather had ever touched her inappropriately. RP

665-6 And again, no charges were filed.

In 2014, TH, now 17 years old, made an accusation

against her stepfather claiming that Mr. Wafford had been

sexually abusing her from the time she was six until the present.

Again, she was interviewed at Dawson Place and by the police.

This time the authorities determined that TH's accusations were

sufficiently credible to justify the filing of charges against Mr.

Wafford. The Snohomish County Prosecutor's Office filed a

two count Information on March 11, 2015. CP 250-51 The

Information charged Mr. Wafford with Rape of a Child in the

First Degree and Child Molestation in the First Degree. The

named victim was TH. After the filing of that Information, but

before the matter went to trial, TH's older sister, HF, came

forward and stated that she also had been sexually abused by



her stepfather, Ron Wafford. RP 814 The State then filed an

Amended Information. In the first three counts! Rape of a Child

in the First Degree, Child Molestation in the First Degree, and

Incest in the First Degree, TH was the named victim. In coimts

four through six: Rape of a Child in the First Degree, Child

Molestation in the First Degree, and Child Molestation in the

Third Degree, HF was the named victim. CP 17 Mr. Wafford

entered pleas of not guilty and the matter proceeded to a jury

trial.

Prior opening statements the Court conducted a child

hearsay hearing. When Ms. Robinson interviewed TH in 2005,

TH was 8 years old. The State sought to introduce the

videotaped interview as child hearsay. After listening to the

testimony and viewing the videotape the Court concluded that

TH had not made any statements that fell within the child

hearsay statute and denied the State's motion to admit the

videotape. RP 82 When asked by the prosecutor to reconsider

Judge Appel stated;



Now, I won't add very much to my remarks of yesterday,

perhaps just a little bit. I don't think it is at all clear that the

legislature was attempting to make a vehicle by which another

person's description, if that's what this was, could be attributed

to a child witness. But even if that is so, even if the purpose of

this statute was so as to permit the mere assent of a child to

another person's description of sexual contact, I don't think that

would make a difference in this case, because there simply isn't

really a description of sexual contact contained within the

statement.

RP200.

The State began its opening statement by telling the jury:

It was a close call, but he got away with it the first
time. At age eight, TH was confused, anxious,
uncertain, and either unable or unwilling to
articulate what it was that her stepfather had been
doing to her. RP 426
In her opening statement defense counsel took the jury

through the various investigations and told them that TH did



not accuse Ron of anything until 2014. Regarding the 2005

video clip counsel stated:

And she brought both HF and TH to Dawson Place
in 2005. Nova Robinson interviewed on video TH
and built rapport and made sure she was
comfortable and made sure she knew she wasn't in
trouble and made all of the things that in her
training she's supposed to do to create an
environment where, if a crime was happening to a
child, that child would feel safe to disclose. But
TH denied that anything was happening to her. She
knew in third grade at age eight what was bad
touch, good touch, and she denied that any of those
things were happening to her. RP 444-5

The State did not object during defense counsel's opening.

Following the defense opening the deputy prosecutor

asked the Court to reconsider and to admit the video tape from

the 2005 forensic interview. It based its request on its

contention that defense counsel "opened the door" when she

made the remarks set out above. Defense counsel explained the

context for her remarks, telling the Court that she was advising

the jury that TH in 2005 denied that her step father touched her

in an inappropriate manner. However, Judge Appel sided with



the State and held that the State would be allowed to introduce

into evidence a portion of the taped forensic interview. A

transcript of the portion admitted as Exhibit 31 is attached

hereto and incorporated by reference in Appendix B.

During the defense case, Ron denied ever touching either

girl inappropriately. He and Mariyah provided the jurors with

reasons why TH would lie about her accusations. They

recounted problems with TH's behavior and how TH wanted to

move from their home to her boyfriend's home. RP 1408-10,

1549-51 The defense brought out that HF repeatedly had denied

being victimized by Ron and only came forward when she was

told that a disclosure by her would enhance TH's credibility.

The defense also introduced testimony that HP's disclosure

only came after her parents began pressuring her . to make

payments on money that they lent to her. RP 1583-84 The

defense called several other witnesses to substantiate its theory

of the case. Witnesses testified about problems in the

relationship of the alleged victims and the defendant. It brought



out the denials by both step daughters to the investigators and

discussed the agendas of the girls.

The jury convicted on Count 2, but could not reach a

unanimous verdict on counts 1, 3-4. Judge Appel declared a

mistrial on these counts and sentenced Mr. Wafford to 68

months in prison. Mr. Wafford filed a timely appeal. Division

One affirmed his conviction on May 15,2017.

VI. ARGUMENT AS TO WHY REVIEW SHOULD BE
GRANTED.

Mr. Wafford asks this Court to accept review of his case

on the following ground: (1) The decision of the Court of

Appeals conflicts with a decision of the Supreme Court.

The Court of Appeal's decision can be summarized as

holding that the trial court has discretion to admit otherwise

inadmissible evidence offered by the prosecution, to rebut

assertions made by defense counsel during opening statement.

1. The decision conflicts with a decision from the

Supreme Court.



Mr. Wafford relies on two Supreme Court decisions to

support his contention that the Court of Appeals Opinion in the

case at bar conflicts with two prior decisions. He also contends

that the Court of Appeals misinterpreted the holding in State v.

Rupe. 101 Wn.2d 664, 683 P.2d 571 (1984), the authority on

which the Court of Appeals based its decision in this case.

In Corson v. Corson, 46 Wash. 2d 611, 283 P.2d 673

(1955), one issue before the Court was whether evidence should

have been allowed to rebut statements made by opposing

counsel in his Opening Statement. The Court ruled that rebuttal

evidence was not admissible even if counsel had "opened the

door," stating:

Respondent, however, argues that the issue of
predivorce conduct was opened up by counsel for
appellant because of certain allegations in his opening
statement, and, therefore, respondent was entitled to
rebut these allegations. We think otherwise. If
appellant did in fact open up the question of the
predivorce conduct of the parties by remarks made in
her counsel's opening statement, this did not justify
the trial court in receiving further testimony on this
issue, offered in rebuttal by respondent. Erroneous
admission of evidence is not cured by the reception of



additional inadmissible evidence, even though the
latter is admitted to counter the possible prejudicial
effect of the former. In making inadmissible and
prejudicial remarks in the opening statement for
appellant, counsel should have been stopped by the
court, advised to desist, and told that such matters
would be disregarded by the court. The same
disposition should have been made of the efforts at
rebuttal by counsel for respondent.

Under Corson statements made during opening statement

do not open the door for otherwise inadmissible evidence and

the video clip offered by the State in this case would have been

rejected.

The issue in State v. Whelchel, 115 Wash.2d 708, 801

P.2d 948 (1990) took on a somewhat different analysis as

defense counsel addressed the contents of a tape recording of

co-defendants which it anticipated, based on the trial court's

pretrial ruling, would be admitted during the State's case. The

State, although not having mentioned the tape recording during

its opening, did admit it during its case in chief. On appeal the

Supreme Court ruled the tape recording inadmissible. The State

sought to justify its admission based on invited error, that

10



defense counsel had "opened the door" by mentioning the tape

recording during its opening. The Supreme Court rejected this

argument stating:

It is well settled that any party may, in opening
statement, refer to admissible evidence expected to
be presented at trial. More specifically, defense
opening statements will generally cover what the
defense expects to be able to prove, an outline of
the expected weaknesses in the State's anticipated
proof, or may simply remind the jurors to reserve
judgment until all the evidence is in. Defense
counsel may also use the opening statement to
emphasize the concept of reasonable doubt. This
means, in part, telling the jury the ways that
defense counsel claims that he or she will be able
to demonstrate uncertainties in the State's case.

State V. "Whelchel, 115 Wash. 2d at 727.

The Comf of Appeals in its decision attempts to

distinguish Corson and Whelchel which support Mr. Wafford's

position, relying instead on State v. Rune. It interprets Rupe to

give the trial judge discretion to admit inadmissible evidence

whenever the Judge feels it is necessary to correct a perceived

unfairness created by remarks made during opening statement.

11



Rupe can be harmonized with Corson and Whelchel, but

not as interpreted by the Court of Appeals and not as authority

for the legal principle decided by the Court. In Rupe, defense

counsel stated in his opening statement that a phone call to the

bank, answered by the husband of one of the victims of the.

shootings, would show that he likely was the shooter. The State

admitted the 911 call.^ One issue addressed on appeal was

whether the trial court erred by allowing that call to be admitted

into evidence. The Supreme Court held that the call was

relevant, under ER 403, though it is questionable whether the

defense counsel's remarks in opening statement was essential to

that holding. The discovery of two women who had been shot,

and the report of this to a caller, would seem to be relevant in a

murder trial regardless of defense counsel's opening statement.

The husband's statements to the caller, made just after finding

^ From the Court's opinion, it is not clear whether the defense
objected to the admission of the 911 call. However, since it
was reviewed on appeal without any mention that the defense
failed to object, it is fair to presume that it was admitted over
the defense objection.

12



the two wounded women, fall with ER 803(a)(2)(excited

utterance- "[a] statement relating to a startling event or

condition made while the declarant was under the stress of

excitement caused by the event or condition.") The issue

presented to the Supreme Court does not appear to be the

relevance of the phone call, but whether its prejudicial impact

caused by its emotional content, outweighed its probative

effect. Such a determination is clearly within the trial court's

discretion and subject to an abuse of discretion standard.

Rupe mentions neither Corson nor Whelchel. Rupe does

not hold that statements made by defense counsel during

opening statement justify the admission of inadmissible

evidence. Rupe does not hold that the prosecution can lie in

wait hoping that defense counsel will make an expansive

statement during opening, fail to object to that statement, and

then introduce otherwise inadmissible hearsay to rebut it. By so

interpreting it in this manner the Court of Appeals erroneously

rejected the language from Corson and Whelchel that rejected

13



the argument that defense counsel can open the door through

remarks made during opening statement. As the Court routinely

advises jurors during preliminary instructions and as Judge

Appel did in Mr. Wafford's trial: The lawyers' remarks,

statements, and arguments during this trial are intended to help

you understand the evidence and apply the law. They are not

evidence, however, and you should disregard any

statements or arguments by the lawyers which are not

supported by the evidence or by the law as I give it to

you. RP 421 (emphasis added). If statements made during

opening are not evidence, they should not "open the door" to

otherwise inadmissible evidence. See also, 5D Karl B. Tegland,

Washington Practice: Evidence § 103 (2003). The remedies

mentioned in Corson provide sufficient protection to a party

arguably aggrieved by the opponent's opening. Rupe should not

be read as authority that statements made during opening can

"open the door" to othei*wise inadmissible evidence and it was

error for the Court of Appeals to do so.

14



Additionally, the video clip admitted by the Court did not

rebut the assertions made by defense counsel. In the case at bar

defense counsel did no more than that which the Court

approved in Whelchel; she discussed the evidence that she

believed would be admitted at trial. It is important to remember

that neither TH, Nova Robinson, the forensic interviewer, Det.

Pitocco, the lead investigator, nor Judge Appel, viewed TH's

statement as describing an act of inappropriate sexual contact.

TH, during her trial testimony denied making a disclosure.

Ms. Robinson^ and Det. Pitocco'^ also testified that TH did not

make a disclosure. What Ms. Goykhman told the jurors during

her opening statement was that TH, in 2005, denied that

anything was happening to her, that she denied that she was

being touched in a bad way. As noted by the Supreme Court in

Whelchel. defense counsel has an obligation to show the

weaknesses in the State's case during its opening statement. In

^RP699
^RP 561, 628, 648, 699
^89

15



the case at bar defense counsel wanted to establish from the

outset that TH had denied being touched inappropriately by her

step-father. The video clip did not rebut this. TH stated during

that interview that no one had touched her where it's not

okay to be touched. Her acquiescence to Ms. Robinson's

question, whether anyone ever asked her to do anything to

any parts of their body where it is not okay to be doing

things, did not rebut defense counsel's remarks. Had the court

followed Corson and Whelchel it would have excluded the

video clip.

vn. CONCLUSION

The Court of Appeals reliance on State v. Rune, supra

was erroneous. Its decision in the case at bar conflicts with the

Supreme Court's decisions in State v. Whelchel and Corson v.

Corson, supra. State v. Rune did not hold that statements made

during opening statement open the door to otherwise

inadmissible evidence. The Court of Appeals erred when it so

interpreted Rupe. This Court should accept review, Imut Rune

16



to its facts, and reverse Mr. Wafford's conviction and order a

new trial.

DATED TfflS /3 DAY OF 2017.

MARK D. MESTEL, WSBA# 8350
Attorney for Appellant
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Vin. CERTIFICATE OF SERVICE

I hereby certify that a copy of the foregoing Petition for

Review was served upon the following by United States Postal

Service, addressed to:

1. Court of Appeals 2. Snohomish County Prosecutor
Division One 3000 Rockefeller Ave

600 University Street M/S 504
One Union Square Everett, WA 98201
Seattle, WA 98101

3. Ronald Wafford, DOC#389997
Coyote Ridge Corrections Center
PO Box 769

Connell, WA 99326

DATED this _ll_ day , 2017.

Brandy L. Ellis, Legal Assistant
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State V. Wafford

Court of Appeals of Washington, Division One

April 10,2017, Oral Argument; May 15,2017, Filed
No. 75164-6-1

Reporter

2017 Wash. App. LEXIS 1177 *

The State of Washington, Respondent, v. Ronald
Wafford, Appellant.

Prior History: [*1] Appeal from Snohomish Superior Court.
Docket No: 15-1-00624-4. Judge signing: Honorable George
F Appel. Judgment or order under review. Date filed:
04/29/2016.

Core Terms

door, opening statement, recording, trial court, interview,
video, opened, rebut, inadmissible evidence, molestation, first
degree, inadmissible, admissible, admitting, hearsay, argues,
sexual abuse, contends, admitting evidence, defense counsel,
sexual

Case Sttinmary

Overview

HOLDINGS: [l]-Court did not abuse its discretion in
g<tmining into evidence a portion of the video recording it had
previously excluded because the rwording was not hearsay
under Wmh. R. Evid. SOKdiam and the door had been
opened by a comment made by counsel during her opening
statement; it is within a court's discretion whether the door is
opened to otherwise inadmissible evidence by statements of
counsel and, if so, what, if any, remedy is appropriate; [2]-
Counel was not ineffective because her failure to request a
Hmiring instruction could be considered a legitimate trial
tactic.

Outcome

Conviction affirmed.

LexisNexis® Headnotes

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

Criminal Law & Procedure > Trials > Opening Statements

fl7V7[A] It is well settled in Washington that a party that
introduces evidence of questionable admissibility runs the risk
of opening the door to the admission of ofterwise
inadmissible evidence by an opposing party. It is within a trial
court's discretion whether the door is opened to othe^se
inadmissible evidence by statements of counsel and, if so,
what, if any, remedy is appropriate.

Criminal Law & Procedure > Trials > Judicial Discretion

Criminal Law & Procedure >... > Standards of Review > Abuse
of Discretion > Evidence

fflV2[i] A decision to admit evidence lies within the sound
discretion of a trial court and should not be overturned absent
a manifest abuse of discretion. An abuse of discretion exists
when the trial court?s exercise of its discretion is manifestly
unreasonable or based upon untenable grounds or reasons.
The range of discretionary choices is a question of law and a
judge abuses his or her discretion if the discretionary decision
is contrary to law.

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

//TVjj-Jb] A party may open the door to otherwise
inadmissible evidence by introducing evidence that must be
rebutted in order to preserve fairness and determine the truth.
The party who introduces evidence of questionable
admissibility may open the door to rebuttal with evidence that
would otherwise be inadmissible, and the party who is the

MARKMESTEL
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first to raise a particular subject at trial may open the door to
evidence offered to explain, clarify, or contradict the party's
evidence.

Criminal Law & Procedure > Trials > Bench Trials

rVimiTifll Law & Procedure > Trials > Opening Statements

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

Criminal Law & Procedure > Trials > Judicial Discretion

In the context of a bench proceeding, a trial court
abuses its discretion by admitting irrelevant and prejudicial
evidence in response to an improper opening statement when
other more effective means of ensuring a fair proceeding are
available. Corson v. Corson does not hold that opening
statemerits can never open the door to otherwise inadmissible
evidence.

evidence. The judge may allow testimony about otherwise
inadmissible evidence, while continuing to exclude an exhibit
or document which contains the evidence. Or the judge may
find that a party has opened the door to otherwise
inadmissible evidence. The appropriate response is that,
which in the discretion of the trial judge, best restores fairness
to a proceeding.

Evidence >... > Exemptions > Prior Statements > Consistent
Statements

jffiV7[ je] A statement is not hearsay if a declarant testifies at
a trial or hearing and is subject to cross examination
concerning the statement, and the statement is consistent with
the declarant's testimony and is offered to rebut an express or
implied charge against the declarant of recent fabrication or
improper influence or motive. Wash. R. Evid. 801(d)n)(ii).

Criminal Law & Procedure > Trials > Judicial Discretion

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

Criminal Law & Procedure > Trials > Opening Statements

Evidence > Relevance > Relevant Evidence

HN5\iiSA A trial court does not abuse its discretion by
fjHmittiug otherwise irrelevant evidence in response to
remarks made during opening statement.

Criminal Law & Procedure > Trials > Opening Statements

Criminal Law & Procedure > Trials > Witnesses

Criminal Law & Procedure > Trials > Jury Instractions > Curative
Instructions

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

Evidence > Types of Evidence > Documentary Evidence

JT/VdAl Whether an issue arises fi'om a statement of counsel
or the testimony of a witness is immaterial to the question
faced by a trial judge: to what extent, if any, has the statement
compromised the fairness of a trial and what, if any, response
is appropriate. In answering this question, the trial judge
should have a range of options at his or her disposal. The
judge may admonish a jury to disregard certain statements or
reiterate its instruction that opening statements are not

Evidence > Admissibility > Procedural Matters > Curative
Admissibility

Criminal Law & Procedure > Trials > Judicial Discretion

A party may open the door to evidence that is
otherwise inadmissible, subject to a trial court's discretion.

Criminal Law & Procedure >... > Standards of Review > De
Novo Review > Ineffective Assistance of Counsel

Evidence > Burdens of Proof > Allocation

rfiminnl Law & Procedure > Counsel > Effective Assistance of
Counsel > Trials

flWPlAl An appellate court reviews an ineffective assistance
of counsel claim de novo. A defendant has the burden of
establishing ineffective assistance of counsel. The
performance of an attorney is not deficient if it can be
considered a legitimate trial tactic.

Headnotes/SyUabus

Summary

WASHINGTON OFFICIAL REPORTS SUMMARY

Nature of Action: Prosecution for two cotmts of first degree
rape of a child, two counts of first degree child molestation.
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CrinuDal Law > Evidence > Opening the Door > Opening

Statement Remarks by Defense Counsel > Effect > Discretion of
Court

Remarks tnade by defense coimsel in opening statement in a
criminal trial can be sufficient to open the door to otherwise
inadmissible evidence. It is within the trial couifs discretion
to determine whether counsel's remarks have opened the door
to otherwise inadmissible evidence and to determine what
remedy, if any, may be appropriate, including allowing
admission of the otherwise inadmissible evidence. The
appropriate response is the one that, in the discretion of the
trial court, best restores fairness to the proceeding.

WA151]M [5]

Criminal Law > Right to Counsel > Effective Assistance of
Counsel > Review > De Novo.

A criminal defendant's challenge to the effectiveness of trial
counsel is reviewed de novo.

W^[A] [6]

Criminal Law > Right to Counsel > Effective Assistance of
Counsel > Burden of Proof.

and one count each of first degree incest and third degree
child molestation.

Superior Court: After entering a directed verdict in favor of
the defendant on the charge of third degree child molestation
and one of the charges of first degree child molestation, the
Superior Court for Snohomish County, No. 15-1-00624-4,
George F.B. Appel, L, on April 29,2016, entered a judgment
on a verdict finding the defendant guilty of first degree cWld
molestation.

Court of Appeals: Holding that the trial court did not abuse
its discretion by ruling that the door was opened to the
aHmigfiinn of Otherwise inadmissible evidence by remarks
made by defense counsel in opening statement and that the
defendant did not prove his claim of ineffective assistance of
trial counsel, the comt affirms the judgment

Headnotes

WASHINGTON OFFICIAL REPORTS HEADNOTES

waoIsM [1]

Criminal Law > Evidence > Discretion of Trial
Court > Admissibility of Evidence.

A convicted defendant claiming ineffective assistance of
The decision to admit evidence in a criminal trial lies withm of proof.
the sound discretion of the trial court.

.  [7]
WAf2IW [2]

Criminal Law > Right to Counsel > Effective Assistance of
Criminal Law > Evidence > Review > Standard of Review. Counsel > Trial Strategy > Tactics > In General.

A trial court's decision to admit evidence in a criminal trial
will not be disturbed by a reviewing court absent a manifest
abuse of discretion. A trial court manifestly abuses its
discretion if its exercise of discretion is manifestly
unreasonable or is based on untenable grounds or reasons.
The range of discretionary choices available to a trial court is
a question Of law, and the court commits an abuse of
discretion if the discretionary decision is contrary to law.

[3]

Evidence > Opening the Door > Introduction of Inadmissible
Evidence > Effect

By introducing evidence that must be rebutted with other
evidence in order to preserve fairness and to determine the
truth, a party may open the door to otherwise inadmissible
evidence.

WAM.^] [4]

A legitimate trial tactic by defense counsel is not deficient
performance and will not support a claim of ineffective
assistance of counsel.

WAMI^] [8]

Criminal Law > Right to Counsel > Effective Assistance of
Counsel > Failure To Request Instruction > Limiting
Instruction > Tactical Decision.

Defense counsel's failure to request a limiting instruction on
damaging evidence wiU not support a claim of ineffective
assistance of counsel if the faUure may be viewed as a
legitimate trial lactic.

Spearman, J., delivered the opinion for a unanimous court.

Counsel: Mark D. Mestel (of Mark D. Mestel, Inc., PS), for
appellant.
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appeals.

DISCUSSION

Opening the Door to Recorded Interview

f 10 Wafford argues that the trial court erred when it found
that his attorney's opening statements opened the door to the
admission of T.H.'s 2005 recorded interview. He primarily
contends that as a matter of law, comments made by counsel
during opening statements cannot open the door to otherwise
inadmissible evidence.

[1, 2] nil The decision to admit
evidence lies within the sound discretion of the trial court and
should not be overtumed absent a manifest abuse of
discretion. State v. Bourseois. 133 Wn.2ci 389, 399. 945 P.2d
1120 11997). An abuse of discretion exists "[w]hen a trial
court's exercise of its discretion is manifestly unreasonable or
based upon untenable grounds or reasons ... ." State v,
Stensnn. 132 Wn.2d 668. 701. 940 P.2d 1239 (1997). The

range of discretionary choices is a question [*6] of law, and
the judge abuses his or her discretion if the discretionary
decision is contrary to law. State v. Neal. 144 Wn.2d 600. 609,
W P.3d 1255 {2001).

[3] ̂ 12 H7V5f?1 A party may open the door to
otherwise inadmissible evidence by introducing evidence that
must be rebutted in order to preserve fairness and determine
the truth. State v. Gefeller. 76 Wn.2d 449. 455. 458 P.2d 17
11969).

"(1) [A] party who introduces evidence of questionable
admissibility may open the door to rebuttal with
evidence that would otherwise be inadmissible, and (2) a
party who is the first to raise a particular subject at trial
may open the door to evidence offered to explain,
clarify, or contradict the parly's evidence."

State V. Jones. 144 Wn. Aw. 284, 298. 183 P.3d 307 (2008)
(quoting 5 BCARL B. TEGLAND, WASHINGTON PRACTICE:
Evidence Law and Practice § 103.14, at 66-67 (5th ed.
2007)).

1113 Wafford argues that only the introduction of evidence can
open the door to otherwise inadmissible evidence. He
contends that because a comment made during an opening
statement is not evidence, it caimot open the door. Wafford
relies on State v. Whelchel. 115 Wn.2d 708. 801 P.2d 948
fl990) to support his argiunent, but the case is not helpful. In
Whelchel, the trial court fotmd a recording admissible prior to
trial. The State did not discuss the recording in opening
statements, but defense counsel did. When the recording was
ruled inadmissible on appeal, the Supreme Court [*7] rejected

flie State's argument that defense counsel opened the door by
discussing the recording in opening statements. Id. at 728.
Given that the evidence in question was admissible when the
parties made opening statements, Whelchel does not stand for
the broad proposition that opening statements cannot open the
door.

1114 Wafford also relies on Corson v. Corson, 46 Wn,2d 611,
2SS p.2d 673 (1955). but to the extent the case is relevant, it

does not siqjport his argument In Corson, the trial court held
a show cause hearing to determine whether a father should be
held in contempt for failure to pay child support as previously
ordered. In the course of the hearing, the trial court admitted
evidence of the mother's predivorce conduct. On appeal, the
Supreme Court concluded that the trial court erred in
aHmifting the evidence. It rejected the father's argument that
the evidence was necessary to rebut remarks made by the
mother in opening statements. The court found fliat even if the
mother had introduced the subject of predivorce conduct in
her opening statement, it did not justify receiving further
testimony on the issue because the trial court had other, more
appropriate means of addressing the matter. The court stated:

In maWng inadmissible and prejudicial [*8] remarks in
the opening statement for [the mother], counsel should
have been stopped by the court, advised to desist, and
told that such matters would be disregarded by the court
The same disposition should have been made of the
efforts at rebuttal by counsel for [the father].

Id., at 616-17.

HI 5 Our reading of Corson is that HN4\'^] in the context of a
bench proceeding, a trial court abuses its discretion by
aHmifting irrelevant and prejudicial evidence in response to an
improper opening statement when other, more effective
means of ensuring a fair proceeding are available. The case
does not hold, as Wafford suggests, that opening statements
can never open the door to otherwise inadrmssible evidence.

1(16 To resolve whether opening statements can open the
door, we find State v. Ruve, 101 Wn.2d 664. 683 P.2d 571
(1984) (plurality opinion) to be more on point and thus more
persuasive. In Rupe, defense counsel suggested in opening
statement that the victim's husband, rather than the defendant,
was responsible for her murder and that of one other person.
As a result of those remarks, the State moved to admit an
emotional recording of the victim's husband calling 911. The
trial court admitted the recording to rebut the inference that
the victim's husband was culpable. Id. at 687.

1fl7 On appeal, Rupe contended [*9] that the trial court erred
in aHmifting the evidence because the probative value of the
recording was far outweighed by its prejudicial effect. The
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Opinion by: Michael Spearman

Opinion

f 1 Spearman, J. — It is well settled in Washington
that a party who introduces evidence of questionable
admissibility runs the risk of opening the door to the
admission of o&erwise inadmissible evidence by an opposing
party. It is less clear whether the rule is triggered only by the
introduction of questionable evidence or whether a statement
by cotmsel regarding such evidence is sufficient. In this case,
appellant Ronald Wafford contends the trial court erred when
it found the door was opened by a comment made by his
coimsel during her opening statement and admitted evidence
it had previously ruled inadmissible. We conclude that it is
within the trial court's discretion whether the door has been

opened to otherwise inadmissible evidence by statements of
counsel and, if so, what, if any, I*2J remedy is appropriate.
Here, die trial court did not abuse its discretion when it foimd
the door had been opened and admitted into evidence a
portion of the video recording it had previously excluded We
affirm Wafford's conviction.

FACTS

^2 Several times over the comse of her childhood, T.H.
accused Wafford, her stepfather, of inappropriate sexual
contact. In 2005, T.H.'s mother, Mariyah Wafford, heard that
eight-year-old T.H. had told a Mend that something
inappropriate had happened with Wafford. After reporting to
police, Mariyah took TJI. to be interviewed at Dawson Place
Child Advocacy Center in Snohomish County. There, a child
forensic interview specialist talked with T.H., and their
conversation was video recorded. T.H. did not make a specific
disclosure of sexual abuse by Wafford, though she did appear
to nod affirmatively in response to one question about
inappropriate sexual contact The State did not investigate
further or charge Wafford.

^3 Seven years later, in 2012, T.H. again told a Mend that
Wafford sexually abused her. The Mend then passed along
the allegations to police, who interviewed her at school. Upset
about the investigation, T.H. told investigators that there [*3]
was nothing going on. No charges were filed.

^4 Two years later, in 2014, T.H. was 17 years old. She was

having problems at home and at school, where she failed to
regularly attend classes. T.H. started seeing a counselor at
school to talk about her anger. Eventually, T.IL disclosed to
her counselor that Wafford sexually abused her. The matter
was reported to police. T.H. was removed from her home and
began living with her biological father in Motmt Vemon.
During the investigation, T.H.'s older sister, H.F., also made

that she had been sexually abused by Wafford.

TI5 The State charged Wafford with crimes against both T.H.
and H.F. As to T.H., Wafford was charged with first degree
rape of a child, first degree child molestation, and first degree
incest As to H.F., Wafford was charged with first degree rape
of a child, first degree child molestation, and third degree
child molestation.

|6 Before Mai, the court conducted a child hearsay hearing at
which it concluded that the 2005 recorded interview of T.H.
was inadmissible. The court reasoned that because T.H. never
actually described an act of sexual contact, her statements
were not admissible under the child hearsay statute. [*4]

^7 In opening statements, the State began by telling the jury,
"It was a close call, but he got away with it the first time. At
age eight, [T.H.] was confused, anxious, uncertain, and either
unable or unwilling to articulate what it was that her
stepfather had been doing to her." Verbatim Report of
Proceedings (VRP) at 426. The prosecutor went on to say that
"[ejventually [T.IL] ended up talking to a police officer,
tatlfing to an interviewer, [who] ask[ed] her questions about
what was happeiring." VRP at 428. He told the jury that it
would hear testimony from two people involved in that initial
investigation. During defense counsel's opening statement,
she referred explicitly to the video of T.H.'s interview;
"[Mariyah] brought both [H.F.] and [TJI.] to Dawson Place
in 2005. Nova Robinson interviewed [T.H.] on video [b]ut
[T.H.] denied that anything was happening to her." VRP at
444. The State did not object

^8 After opening remarks, the State requested that the coiut
admif: the interview video that had been previously excluded.
The State argued that when defense counsel mentioned the
video, she opened the door to its admission. The State
contended that the jury must see the video to rebut the
characterization that T.H. denied abuse in [*5] her interview.
Finding that defense counsel opened the door, the court
admitted a portion of the video.

^9 At Mai, Wafford successfiilly moved for a directed verdict
on counts V (first degree molestation of H.F.) and VI (third
degree TP"l"siatifin of H.F.) for insufficient evidence. The jury
found Wafford guilty of first degree child molestation of T.H.,
but was unable to reach a verdict on the remaiiung counts.
The court sentenced Wafford to 68 months in prison. Wafford
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Supreme Court acknowledged the recording's prejudicial
effect, noting that it was, "without a doubt, an extremely
emotional experience to listen to th[e] tape." Id. at 686. But it
held that the Irial court did not abuse its discretion in
admitting the tape. Id. at 688. The court agreed with the State
that because the defense theory, as asserted in opening
statement, was that the husband was responsible for the
murders, the recording was relevant and admissible to rebut
that assertion. While the Supreme Court did not expressly rely
on the open door doctrine in reaching this result, Rupe
supports the conclusion that HN5\'^] a trial court does not
abuse its discretion by admitting otherwise irrelevant
evidence in response to remarks made during opening
statement

[4] K18 We decline to adopt WafFord's suggested
rule that as a matter of law, comments made during opening
statements cannot open the door. First, such a rule would be
contrary to the general rule permitting trial courts the
discretion to determine the admissibility of evidence. Second,
gM[Y] whether the issue arises from the statement 1*10] of
counsel or the testimony of a witness is immaterial to the
question faced by the trial judge; to what extent, if any, has
the statement compromised the fairness of the trial and what,
if any, response, is appropriate. In answering this question,
the trial judge should have a range of options at his or her
disposal. A judge may admonish the jury to disregard certain
statements or reiterate its instruction that opening statements
are not evidence. The judge may allow testimony about
otherwise inadmissible evidence while continuing to exclude
the exhibit or document that contains the evidence. Or the
judge may find that a party has opened the door to otherwise
inadmissible evidence. The appropriate response is that
which, in the discretion of the trial judge, best restores
fairness to the proceeding.

1(19 Wafford next argues that even if comments made during
opening statement can open die door, the trial court abused its
discretion in finding that counsel did so in this case. He
cnntpnHs that counsel merely previewed the testimony of two
witnesses, which he argues did not make the video recording
of T.H.'s interview relevant But the trial court reasoned that
counsel opened the door because [*11] she

referred to the video that was made from the interview,
and [she] said that [T.H.] denied anything was happening
to her, and [she] said that twice.
It would be fundamentally unfair to leave it like that 1
said the State could not use this item of evidence, and
then [she] told die jury what was inside the evidence. So
things have changed, and the door is now open.

VRP at 452. We agree. Prior to trial, Wafford successfully
excluded the recording. In its opening statement, the State
discussed the interview, but did not reference a video. Then,

in her opening remarks, Wafford's counsel told the jury that
there was a video, and that in it T .H. denied the abuse. Thus,
Wafford was the first to identify the existence of the
recording, which he went on to characterize as containmg a
f]Rnia1 of the abuse. Because these statements made continued
exclusion of the recording unfair to the State, the trial court
did not abuse its discretion in finding that counsel's opening
statements opened the door to its admission.

^20 Next, Wafford argues that the trial court erred by
ffrtmitting the recording because it was inadmissible hearsay
and therefore incompetent evidence. The State contends that
the recording was not hearsay because it rebutted [*U] a
claim of recent fabrication. The State is correct. HN7\^\ A
statement is not hearsay if "[t]he declarant testifies at the trial
or hearing and is subject to cross examination concerning the
statement, and the statement is ... consistent with the
declarant's testimony and is offered to rebut an express or
implied charge against the declarant of recent fabrication or
improper influence or motive ... ." ER 80I(d)(])(ii),. In
opening statements, Wafford theorized that T.H. recently
fabricated the sexual abuse in order to live with her boyfriend.
The interview recorded almost 10 years earlier tends to rebut
this theory. In it, T.H. indicated diat Wafford acted sexually
toward her by slightly nodding her head in response to the
question, "Has anybody ever shown you any parts of their
body that it's not okay for kids to see? Ex. 3 at 17. An
affirmation of sexual conduct is consistent with her testimony
and is thus not hearsay under ER 801(d)(1).

]I21 The trial court did not err by admitting the video of T.H.'s
2005 interview.'

Ineffective Assistance of Counsel

TI22 Wafford argues that his attorney provided ineffective
assistance of counsel because she failed to request a limiting
instruction for the video of T.H.'s 2005 interview. He
contends that [*13] his counsel should have sought a jury
instruction that would limit consideration of the recording as
evidence rebutting her characterization of the video as a
denial of sexual abuse. The State argues that this was a
IpgifimatR trial tactic because in closing statements, counsel
used the videos to argue for the truth of the matter asserted:
whether Wafford abused T.H.

•We also disagree with Wafford's contention that hears^cannot be
admitted even when a party opens the door to it A party
may open the door to evidence that is otherwise inadmissible, subject
to the trial court's discretion. Havsom v. Coleman Lantern Co.. 89
Wn.ld 474. 573 P.2d 785 0978)-. State v. Tannan. 27 Wn.
Ann. 645. 651. P.2d 73711980).
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WAr5-71\^'\ [5-7] 1123 Hm\^] We review an ineffective
assistance of counsel claim de novo. State v. White, 80 Wn.
Ann. 406. 410. 907 P.2d 310 (1995). The defendant has the
burden of establishing ineffective assistance of counsel. State
V. Humnhries. 181 Wn.2d 708, 719-20. 336 P.3d } 121 (2014),
The performance of an attorney "is not deficient if it can be
considered a legitimate trial tactic." Id. at 720 (citing State v.
Hendrickson. 129 Wn.2d 61. 77-78. 917 P.2d 563 (1996)).

WA18]^] [8] 1(24 Here, defense counsel's failure to request a
limiting instruction can be considered a legitimate trial tactic..
During closing arguments, counsel used the 2005 recording in
defense of her client She argued that T.H.'s responses to the
interviewer's questions about molestation "were emphatically
no." VRP at 1636. A limiting instruction would have
prevented counsel from arguing that the recording proved that
there was no molestation. Thus, the failure to request a
limiting instruction was not deficient performance by
Wafford's attorney.

1125 Affirmed.

DwYERand [*14] Cox, JJ., concur.
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14

NR: Okay. Tyran, is there any place on your body where it is not okay to touch?
15

TH: There.
16

17

18

19

20

21

22

23

24

25

26

27

28

NR: Okay. Any place there?

TH: There.

NR: Uhhuh.

TH: There. - ' ' '

, NR: Okay. Any place else? It's not a test. Ai-e those all the places?

TiS: (just giggling) no audible response

NR: Okay. There are no right or wrong answers, it's up to you what you want-to'tell me about

}

okay? • •

TH: Uhhuh.
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;1

2

3

4

5

6

7

8

9

10

13

14

15

16

17

18

19

20

21

■ 22

23

24

25

26

27

28

NR: ' And so you said right here where you said you don't want to say on the girl drawing and tihen

right here where you're not really sure what it's called that's below the mouth and above the

belly button. And then you said right here on the part you called the butt.

TH: Uh huh.

NR: If you think of any place else I want you to let me know okay?

TH: Uh huh.

NR: Has anyone touched you someplace on your body where it's not okay?

TH: Not that I know of.

NR: . Okay., Have you told somebody that you were touched on your body where it's not okay to be

touched?

TH: No.

NR: Okay. Has anybody ever asked you to touch them on their body where it's not okay for you to

touch them?

TH: Huh uh.

NR: Has anybody ever shown you any parts of their body that it's not okay for kids to see?

TH: Not that I know of.

NR: Okay. Has anybody ever asked you.to do anything to any parts of their body where it's not

okay to be doing things?

TH: Uh...

NR: What?

TH: I'm not really what it, sure what it's called actually.

NR: Just do your best. Tell me about what was going on, where you were at, who was there, what

was happening, that helps me understand.
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10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

TH: Uh my daddy and I'm not sure what was happening actually cause I don't know what it's
2

called:
3 '

^ NR: Okay. Alright. It was your daddy? And is that the daddy you told me about on here on this

5  picture named Ron?

6  TH: Uhhuh.

^ NR: Or a different daddy?

TH: That daddy.

NR: That daddy? Okay. And where were you at when that was happening?

TH: My house.

NR: Okay, where at at your house?

TH: hi the garage.

NR: In the garage. Is that the only place something like that ever happened or any place else?

TH: Huhuh.

NR: Huh uh what?

TH: There is no other place that that happened.

NR: Okay. Just in the garage? And is that the only time something like that happened or were there

more than one time?

TH: More than one time. •

NR: Okay.' And 1 know that you're eight years old, you're almost nine...

TH: Yeah.

NR: ...so I know you can probably count.

TH; Uhhuh. • .

NR: Can you count to ten for me?

TH: one, two, three, four, five, six, seven, eight, nine, ten.
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NR: Okay. And did the thing that happened with your daddy happen more than ten times or less
2

than ten times or'about ten times or...
3

^  TH: About ten times, I'm not really sure.

5  NR: You're not really sure?

6  TH: I'm not really sure.

^ ' NR: Okay. And have you ever seen that happen with any other kids or any other people?

„ TH: No. ■ ' . •
9

NR: Okay. And was anybody else ever with you when that happened?
10

1 1
TH: .. .no audible response.
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